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Introduction

This document is intended for use with the Cognos 8 Planning - Contributor Web Client. This guide

describes how you can use Cognos 8 Planning - Contributor to see the current state of your plan,

and explains how to enter and review data.

Cognos 8 Planning provides the ability to plan, budget, and forecast in a collaborative, secure

manner. The major components are Analyst and Contributor.

Cognos 8 Planning - Analyst

Analyst is a flexible tool used by financial specialists to define their business models. These models

include the drivers and content required for planning, budgeting, and forecasting. The models can

then be distributed to managers using the Web-based architecture of Cognos 8 Planning -

Contributor.

Cognos 8 Planning - Contributor

Contributor streamlines data collection and workflow management. It eliminates the problems of

errors, version control, and timeliness that are characteristic of a planning system solely based on

spreadsheets. Users have the option to submit information simultaneously through a simple Web

or Microsoft Excel® interface. Using an intranet or secure Internet connection, users review only

what they need to review and enter data where they are authorized.

For more information about using this product, visit the Cognos Global Customer Services Web

site (http://support.cognos.com).

Best Practices for Cognos 8 Planning

The Cognos Innovation Center™ for Performance Management provides a forum and Performance

Blueprints which you can use to discover new ideas and solutions for finance and performance

management issues. Blueprints are pre-defined data, process, and policy models that incorporate

best practice knowledge from Cognos customers and the Cognos Innovation Center. These Blueprints

are free of charge to existing customers or Platinum and Gold partners. For more information about

the Cognos Innovation Center or the Performance Blueprints, visit http://www.cognos.com/

innovationcenter.

Audience

To use this guide, you should have an understanding of Cognos 8 Planning - Contributor and

Cognos 8 Planning - Analyst.

Related Documentation

Our documentation includes user guides, getting started guides, new features guides, readmes, and

other materials to meet the needs of our varied audience. The following documents contain related

information and may be referred to in this document.

User Guide 5

http://support.cognos.com
http://www.cognos.com/innovationcenter
http://www.cognos.com/innovationcenter


Note: For online users of this document, a Web page such as The page cannot be found may appear

when clicking individual links in the following table. Documents are made available for your

particular installation and translation configuration. If a link is unavailable, you can access the

document on the Cognos Global Customer Services Web site (http://support.cognos.com). Logon

credentials are available either from your administrator or by request from support.america@cognos.

com.

DescriptionDocument

Using the Cognos 8 Planning - Contributor for Microsoft Excel®Contributor for Microsoft

Excel® User Guide

Working offline in ContributorContributor Work Offline

Guide

Finding Information

To find the most current product documentation, including all localized documentation, access the

Cognos Global Customer Services Web site (http://support.cognos.com). Click the Documentation

link to access documentation guides. Click the Knowledge Base link to access all documentation,

technical papers, and multimedia materials.

Product documentation is available in online help from the Help menu or button in Cognos products.

You can also download documentation in PDF format from the Cognos Global Customer Services

Web site.

You can also read PDF versions of the product readme files and installation guides directly from

Cognos product CDs.

Getting Help

For more information about using this product or for technical assistance, visit the Cognos Global

Customer Services Web site (http://support.cognos.com). This site provides product information,

services, user forums, and a knowledge base of documentation and multimedia materials. To create

a case, contact a support person, or to provide feedback, click the Contact Us link. For information

about education and training, click the Training link.

Printing Copyright Material

You can print selected pages, a section, or the whole book. Cognos grants you a non-exclusive,

non-transferable license to use, copy, and reproduce the copyright materials, in printed or electronic

format, solely for the purpose of operating, maintaining, and providing internal training on Cognos

software.

6 Contributor

Introduction

http://support.cognos.com
mailto:support.america@cognos.com
mailto:support.america@cognos.com
http://support.cognos.com
http://support.cognos.com


Chapter 1: Use Cognos 8 Planning - Contributor

Contributor streamlines data collection and workflow management. It eliminates the problems of

errors, version control, and timeliness that characterize decentralized planning processes.

Organizations can easily engage thousands of people in the planning process, collecting data from

managers and staff across divisions and across geographies as well as from resellers, suppliers, and

customers worldwide. Many users can work simultaneously because Contributor is optimized for

end-user performance. The client requests data from the server only as needed and saves only data

that has changed. Complex calculations are performed at the client, giving you quick response and

sparing the server unnecessary traffic during high-use times.

Using an intranet or secure Internet connection, you review only what you need to review and enter

data where you are authorized.

You can make current Contributor data available in Cognos 8 Framework Manager for reporting

purposes. You can also use Excel print formatting and preview features, and export current data

to Excel for customized reporting. If you want to use these features and they are not available, ask

your Contributor administrator.

Steps

1. Open a Web browser. Type the Web address supplied by your administrator in the address

bar, typically http://servername/cognos8.

2. Type your user ID and password and click OK.

3. In the Plan and forecast area, click the Contributor link. If you have access to more than one

plan, click the plan that you require.

When you log on to Contributor, you see a graphical overview of all the areas you are responsible

for, and the status of the data.

4. To start using Contributor, in the tree on the left side of the screen, click an item. In the table

that appears, click the name of the item.

5. To show more information about an item, click the blue down arrow. This opens a details

panel that you can close by clicking either of the arrows.

6. To send email, click the name of the person in the Ownership or Reviewer cells or in the details

panel.

7. To start working, click the e.List item in the table. This opens an e.List item in a grid where

you can view and enter data.
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The Workflow Screen
The Workflow screen appears when you log on to Contributor. It consists of a tree, a table, and e.

List items.

The Tree
The tree on the left side of the screen shows the areas that you are responsible for contributing to

(Contributions) and reviewing (Reviews) in a hierarchical form. Depending on your rights, you

may see Contributions, Reviews, or both. When you click an item in the tree, a table with the details

for the item appears on the right side of the screen.

Each item in the tree has an icon that tells you the current state of the data.

State and descriptionIcon

Not started

No changes have been saved to the data, although the contribution may have been

opened for editing.

Work in progress

The data was saved but not submitted. You can change and submit data in this state.

Locked

The data was submitted and the e.List item was locked. Data can only be viewed in this

state. If an e.List item is rejected, its state returns to Work in progress.

Incomplete

At least one item belonging to this item is Not started, and at least one other item is in

a state of Work in progress, Locked, or Ready. Data in this state was aggregated. The

Incomplete state applies only to review e.List items.

Ready

All e.List items belonging to the reviewer e.List item are locked. The data is ready to be

submitted to the next level in the hierarchy.

Currently being edited or annotated

The e.List item was opened for editing or annotating. An edit session is ended by the

user closing the grid, or by submitting the e.List item.

Out of date

Data in the e.List item needs restructuring to reflect changes in the application, or system

data must be imported.
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State and descriptionIcon

Currently being edited or annotated and is out of date.

The Table
The table on the right side of the screen gives information such as the workflow state of the item,

the current owner, the reviewer, and when the item last changed.

If a document is attached to an e.List, an icon appears next to that item .

If Contributor for Excel is installed and configured, you can click the Excel button to open the e.

List item using Contributor for Excel .

If you are a reviewer of an e.List item, you can reject a submitted item from this screen by clicking

the reject button .

e.List Items
An item in the tree or table is known as an e.List item. Typical examples are Sales Division, Marketing

Division, Development Division, and Cost Center 123. The e.List item names depend on the design

of your application.

You can open multiple e.List items at the same time. If you have a multi-e.List item view, it is

indicated by (All) in the first row of the table. Because more data is downloaded to your computer

in a multi-e.List item view, it can take longer to open than a standard e.List item view. This option

may not be available. Contact your administrator for more information.
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Chapter 2: View and Enter Data

When you open a contribution, you can begin to view or enter data depending on your rights and

the state of the data.

Enter Data
Data that you can edit has a white background. Read-only data has a pale gray background.

You can also use Contributor’s cell-based Quick Commands (p. 19).

If you are not the current owner, the data opens in a read-only view.

You can edit data only if it has a workflow state of Not started  or Work in progress . The icon

indicates the workflow state.

Note: Entering large amounts of text can expand the column width so that the Contributor grid is

difficult to use. You may not be able to see the full text within the grid. This is because text formatted

cells do not wrap text. Keep text in cells short to avoid this problem.

Tip: To quickly access commands, right-click the required data or cells, and select the appropriate

command from the menu.

Step to Start Editing

● Click Take Ownership .

Validate Data
Data validation ensures that incoming data in a Contributor application is in the right format and

conforms to existing business rules. These rules, which are defined by the administrator in the

Contributor Administration Console, represent a single data entry requirement imposed on a range

of cells in a single cube of a model.

Validation rules range from the basic checks, such as data type (integer or string) and format (dates)

, to rules that use sophisticated business logic to verify if submitted data is valid. Validation rules

are also associated with actions that ensure contributors conform to the required input, output,

and target requirements, and that only valid data is accepted. A fail action that is associated with

a specific rule can prevent you from saving the plan or submitting it to the next e.List reviewer.

You can check data entry for your plan at any time by using the Validate Data command from the

File menu or the Validate Data button from the toolbar. Because business requirements may change,

it is good practice to validate your data regularly. The benefit of validating data on the Web client

is that it allows the you to validate input data before transmitting it to the Contributor Web server.

If a value is invalid, feedback is provided to assist you with entering information that complies with

existing rules.
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The data validation functionality is also available from the Cognos 8 Contributor for Excel and

while working offline.

Steps

1. Click the dimension tab that contains the target cell range for validation.

2. Enter new data or change existing data as necessary.

3. To verify that the data entries or changes conform to existing business rules and data-format

restrictions, from the File menu, click Validate Data or click the Validate Data toolbar button

.

4. If errors are detected, in the Validation Error dialog box, double-click the error to view its

location in the grid.

Errors that are not resolved may prevent you from saving or submitting the plan. If you are

unable to resolve errors based on the error messages, contact your administrator.

The pointer appears in the first offending cell on the first failed rule in the rule set.

5. Make the necessary changes.

Print Data
You can print data either using the Print to Excel extension, if enabled by your administrator, or

using the standard Contributor Print.

Using the Print to Excel extension, you can print the current view of Contributor data using the

Excel print formatting and preview features. You can also choose to print only certain e.List items

and include commentary.

Steps Using Print to Excel

1. From the File menu, select Print. The Print to Excel wizard appears. If this is the first time using

this extension, a one-time download from the server will occur.

Note: As two-dimension cubes only have one page to print, Print to Excel forgoes the normal

selection wizard and proceeds directly to the Excel Page Setup screen.

2. The first screen of the wizard displays the tabs that you have selected to print. Each page

drop-down list is represented by a tab in the wizard. Select which items you wish to include

from each page drop-down list by highlighting them with your mouse (Press Ctrl+click to select

more than one page drop-down).

3. If you would like to include commentary, select the Include Commentary check box. For more

information, see "Commentary" (p. 22).

4. If you would like to Include Zero Pages, select the Include Zero Pages check box. Selecting the

Include Zero Pages option will print pages that contain only zero data. Including zero pages

may cause the application to slow down. If you do not select this option, the pages that contained

all zeros will not be printed.
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5. Click Next.

6. If you would like to exclude a page, clear the check box next to the page. You can also change

whether or not you want to include commentary or zero pages by selecting/clearing the check

boxes.

7. Click Finish. The pages are loaded and the Print to Excel-Page Setup dialog box appears.

8. Format the page, margins, and sheet settings as necessary. You can also preview the page by

clicking Preview.

9. Click Print to choose your printer.

10. Click OK to print the desired pages.

Steps using Contributor Print

1. To print, click File, Print. In Contributor print, only the current tab is printed.

2. You can set the following print options for Contributor Print:

● Fit to page width

● Fit to page height

Use Edit Options to Cut, Copy, Paste, and Delete Data

You can cut, copy, paste, and delete data in the grid.

When pasting into multiple cells, the target cells must be compatible with the data you are pasting

into it. For example, you cannot paste a number into a cell that expects a date. If the target selection

is a multiple of the source selection shape, the data will be replicated to fit the selection.

Step

● Select the required data or cells, right-click and select the appropriate option from the menu.

Importing and Exporting Data

You can load data, and export data to and from, a text file. If Get Data is enabled by your

administrator, you can load data from outside sources and copy data within Contributor.

Import from Text File

You can load a text file into the current tab.

The file should be identical in format to a file exported from Contributor as a tab separated text

file.

Step

● Right-click the grid and click Import from Text File.
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Export to Text File

You can save data in the current tab to a tab separated text file.

Step

● Right-click the grid and click Export to Text File.

Get Data

Get Data, if enabled, lets you load data into Contributor, either from other Contributor cubes, or

from external sources.

Step

● If available, click File, Get Data . This option is not available offline.

Update Data

You can see the latest data in the Contributor grid by using the Update command.

You may need to do this when the data that you are viewing has been updated on the server, and

you have received a message such as:

"The data help on the server for <e.List item> is more recent than that displayed".

You may be unable to edit until you have clicked Actions, Update.

Step

● To see the latest data in the Contributor grid, click Actions, and then click Update.

Reset Data
You can reset all data in all of the tabs to the last saved version.

Important: This also resets commentary.

Step

● Click File, Reset All.

Modifying the View
You can modify the view of Contributor data. You can:

❑ Swap items in rows and columns.

❑ Replace rows and columns with a page dimension.

❑ Replace a page dimension with a row or column heading.

❑ Change page dimensions displayed in the view.
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❑ Hide pages, rows, or columns only displaying zeros.

Swap Items in Rows and Columns

If you want to swap the rows and columns that currently appear in the view, do the following:

Step

● From the View menu, click Swap Rows and Columns or click the Swap icon .

Replace a Row or Column With a Page Dimension

To change the view so that a row or column is replaced by a page dimension, do the following:

Step

● Press Shift, click anywhere in the row or column heading, and drag the row or column to the

top of a page.

Replace a Page Dimension with a Row or Column Heading

To change the view so that a page dimension is replaced by a row or column heading, do the

following:

Step

● Click the bar to the left of the page list box, and drag onto a column or row heading.

Change Page Dimensions Displayed in the View

To change the page dimensions displayed in the view, do the following:

Step

● Click the arrow and then select a new item from the list.

Hide Pages, Rows, or Columns Containing Only Zeros

If you want to hide pages, rows, or columns containing only zeros on a tab, do the following:

Step

● From the View menu, click Zero Suppression, or the Zero Suppression icon , and then click

Pages, Rows, or Columns.

Hiding a page containing only zeros may cause the application to slow down.
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View Full Precision Numbers
When numeric values are rounded to a number of decimal places (specified by the format used for

the cell in the Cognos 8 Planning - Analyst D-Cube), you can press F5 to view or edit the full

precision number. When focus moves away from the cell, the display reverts to the normal rounding.

Save Data
After you enter data, you can save the data back to the server and recalculate summary level e.List

items. You can open this e.List item again at a later date.

If you entered a value into a cell that has a validation rule defined, and that value is outside the

bounds of the specified validation rule, a warning message is shown when you attempt to save the

plan. You must correct the data before you can save it to the server.

Steps

1. To save data on the server, click Save.

If errors are identified during the validation process, they are summarized in the Validation

Error dialog box, which shows the location of any of the failed rules.

2. If the Validation Error dialog box appears, double-click the item in the dialog box.

The pointer moves to the first offending cell in the Web grid.

3. Make the necessary changes.

4. To verify that the data entries or changes conform to existing business rules and data-format

restrictions, from the File menu, click Validate Data or click the Validate Data toolbar button

.

Submit Data for Review
You submit an e.List item to the next reviewer in the planning model hierarchy when you are happy

with the data it contains. After you submit the e.list item, the item is locked and you can make no

further changes to the data, although you can annotate. The reviewer can either accept or reject

the changes you made to the e.List item.

If you entered a value into a cell that has a validation rule defined, and that value is outside the

bounds of the specified validation rule, an explanatory or warning message is shown when you

attempt to submit the plan. You must correct the data before you can submit an e.List item to the

next reviewer.

To submit data, you must have submit rights.

Steps

1. From the Actions menu, click Submit, or click the Submit icon .
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If errors are identified during the validation process, they are summarized in the Validation

Error dialog box, which shows the location of any of the failed rules.

2. If the Validation Error dialog box appears, double-click the failed item in the dialog box.

The pointer is moved to the first offending cell in the Web grid.

3. Make the necessary changes.

4. To verify that the data entries or changes conform to existing business rules and data-format

restrictions, from the File menu, click Validate Data or click the Validate Data toolbar button

.

If no error messages appear, totals are calculated and the data is submitted to the reviewer.

5. From the File menu, click Close.

Review Data
e.List items that you are responsible for reviewing are grouped under Reviews.

You can view e.List items that you have the rights for in any state. You can view more than one e.

List item at a time. The e.List items will open in separate windows. When an item has been submitted

for review, it is locked .

If you are not happy with the contents of an e.List item, and you have appropriate rights, you can

reject it, either from the workflow screen, or from the grid by clicking the reject button . The state

of a rejected e.List item changes from Locked to Work in progress . It must be modified and

resubmitted.

You may be prompted to send an email to the owners of the contribution explaining the changes

that must be made before it can be accepted. You can also annotate the contribution, and if you

have appropriate rights, you can edit the contribution. You must take ownership  first.

When all contribution e.List items in a review e.List item have been submitted, it has a Ready state

. If you are happy with all the contents, submit the review e.List item from the grid .

Calculated Cells, Breakbacks and Holds
If you type data into a calculated cell and press Enter, data in other cells that are part of the

calculation are automatically recalculated. If a cell contains calculations, the numbers in it are bold.

A numerical data cell that has no value contains a zero. If the zero is bold, this is a calculated cell.

Calculated cells may have associated business logic or validation rules. If you enter a value in a

calculated cell that is outside the bounds of the rule, an warning message is shown when you attempt

to submit or save the plan. You must correct the data before you can submit an e.List item to the

next reviewer or save the plan to the server. For more information, see "Validate Data" (p. 11).

Typically, totals are split according to the original values contained in the cells that make up the

calculation.
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For example, a cell is the total of Jan through Dec. Typing a total amount into the Total cell and

pressing Enter automatically divides the amount over the 12 months. This is called breakback.

If you type 24,000 in the Total cell and press Enter, each month total is 2000.

TotalDecNovOctSepAugJulJunMayAprMarFebJan

24000200020002000200020002000200020002000200020002000US

If you change the total to 30,000 and press Enter, each month total changes to 2,500.

TotalDecNovOctSepAugJulJunMayAprMarFebJan

30000250025002500250025002500250025002500250025002500US

If you change June to 3000 and press Enter, and then change the total annual cell to 40,000 and

press Enter, the June total changes to 3934 and the other months change to 3279. The month totals

changed proportionally according to the values contained in the cells.

TotalDecNovOctSepAugJulJunMayAprMarFebJan

40000327932793279327932793279393432793279327932793279US

However, if you change the June total to 3000 without pressing Enter and then change the total

annual cell to 40,000 and press Enter, the June total is held at 3000, and the other months change

to 3,364.

TotalDecNovOctSepAugJulJunMayAprMarFebJan

40000336433643364336433643364300033643364336433643364US

Note: If your administrator set an option to recalculate data as your cursor moves from the cell

rather than upon pressing Enter, you need to explicitly hold a value.

Apply or Release a Hold

You can apply a hold to a cell which means that if breakback is used, the held cell is protected from

it. A held cell is turquoise in color.

Step to Apply a Hold

● To apply a hold, right-click the cell, and Hold.

Step to Release a Hold

● To release a held cell, right-click the cell, and click Release.
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Holds are released when you navigate away from the current page.

Quick Commands
You can use the following shortcuts in cells. They can be typed directly in cells.

Copy Commands

Copy commands copy a value or operation to the left, right, above, or below rows and columns in

a table. Copy commands perform an action on cells of the same type as the one in which they were

entered.

You can combine copy and data entry commands, although you should not use them with the Grow

command.

ActionExampleDescriptionCommand

Copies the number 5 to the right5>Copies right>

Increases the row by 6% for each value to the rightinc6>

Adds 15 to each value in the row to the leftadd15<Copies left<

Copies 3 down the column3|Copies down|

Resets the cells down the column to the last saved valuereset|

Holds the cell values up the columnhold^Copies up^

Copies 2 to the right and up the column2>^

Used in conjunction with a copy command to stop

another copy command from advancing beyond the

cell

:Copy stopper:

Data Entry Commands

Typing a data entry command in a cell performs an action on the cell value. Data entry commands

are processed when Enter is pressed.

These commands are not case sensitive.

You can use commands across two dimensions, but not across pages.
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ActionExampleDescriptionCommand

Enters 50005KEnters the cell value in thousands.K

Enters 10,000,00010MEnters the value in millions.M

Adds a number to the cell value.Add, +

Important: For Contributor for Excel, entering +

does not do this. This indicates the start of a

formula and overwrites any existing data in the

cell.

Subtracts 8 from

the cell value

sub8Subtracts a number from the cell value.

Important: A minus sign (-) is not permitted for

subtract in the Contributor cells because this

indicates a negative number in Contributor.

Subtract,

Sub

Multiplies the cell

value by 3

mul3Multiplies the cell value by a number.Multiply,

Mul, *

Gives 5% of the

original cell value

per5Multiplies the cell value by a number entered as

a percentage.

Percent,

per, %

Important: For Contributor for Excel, entering %

does not have the same effect. This converts the

number to a percentage.

Increases the cell value by a number entered as a

percentage.

Increase,

Inc

Decreases the cell

value by 6%

decrease6Decreases the cell value by a number entered as a

percentage.

Decrease

Important: For Contributor for Excel, entering

Dec does not have the same effect. This is

converted to a date format.

Raises the value to

the power of 10

Pow10Takes the cell value to the number entered as a

power.

Power,

Pow
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ActionExampleDescriptionCommand

Increases the value

by 10 percent of the

original value each

period.

G10LGrows cells by a percentage. Only valid in time

dimensions, where each period increases either

linearly, or as a compound value.

Important: Insert the numeric value between the

Grow and Linear/Compound command, such as

Gro10Com, G40L.

Grow

Compound,

Grow

Linear,

GroCom,

GroLin,

GC, GL

Divides cell value

by 1.1

Div1.1Divides the cell value by the number entered.Divide,

Div, /

Resets selected cell values to the last saved version.Reset, Res

Makes the cell value a zero.Zero, Zer

Rounds all cells to

the nearest 100,

where 5475

becomes 5500

Round100Rounds cells to the appropriate level based on

input.

Round,

Rou

Holds the cell value from breakback calculations.Hold, Hol

Releases held cells.Release,

Rel

Link to a Contributor Cell From Another Application
You can copy the universal resource location of a Contributor cell to the clipboard ready to be used

by other applications. This enables you to link directly to the cell from another application.

In order for the link to work, the Contributor application must be available on the computer and

the user must have appropriate rights.

Steps

1. Right-click the cell and click Copy URL.

2. Paste the location into the target application, such as, the address bar of a Web browser.
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Commentary
User annotations and attached documents that are linked to a plan are grouped together to form

commentary. You can copy commentary between Contributor cubes and applications using

administration, system, and local links.

Note: You can only copy commentary using links that contain data.

Annotate Data
There are two types of annotations: user annotations, and audit annotations.

Enter User Annotations

You may want to add notes to your plan. You can do this by annotating a cell, a tab, or the whole

model.

You can annotate cells, tabs, or the model if you can edit or review the e.List item. If you have only

View rights to an e.List item, you cannot annotate.

You can annotate a particular cell, tab or the model once in a session. A session ends when you

save.

Important: After you save or submit a session, you cannot edit an annotation. But the person who

created the annotation can delete it.

Steps

1. Right-click the cell, or tab that you want to annotate.

2. Click Annotate, then select Cell, Tab, or Model, and then click Add .

3. Type your note, and then click OK.

4. To view cell or tab annotations, move your mouse pointer over the red triangle in the top

right-hand corner of the cell or, for tabs, at the top right-hand corner of the first column.

To view a model annotation, right-click in the grid and click Annotate, Model, and then click

View.

To view all annotations for a model, right-click the model and click Browse Commentary. To

view a large annotation in the Commentary Browser, right-click in the cell and click View

Annotation.

You can also browse annotations by clicking View, Browse Commentary.

5. If you want to edit an annotation made in the current session, right-click the cell, tab or model,

click Annotate, then select Cell, Tab, or Model, and then click Edit.

Note: Deleting all the text deletes the annotation.

6. Click Save.

This will also save any data changes.
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View Audit Annotations

Your administrator may have configured your application so that actions you take, such as typing

data, importing files, and copying and pasting data, are recorded as audit annotations. In addition,

system link history can then be stored as an annotation on the cube that was targeted by the link.

If enabled, you can view audit annotations for any cells for which you have at least view access.

Steps

1. To view an audit annotation, right-click the cell, tab, or model and click Browse Commentary.

2. Under Commentary Filter, click Audit Annotation.

Add Links to Annotations

You can include links to Web pages, files and email addresses in annotations.

Link to a file only if you expect the file to be viewed by two or three people. If you expect more

people to view the file, make the file accessible from a Web site.

Before you link to a file, ensure that the file is in a shared network location. Also, use the universal

naming convention instead of a fixed drive letter because a fixed drive letter may not be the same

for the people viewing the annotation.

Steps

1. Right-click the cell, tab, or model annotation that you want to add a link to.

2. Click Annotate, then click Cell, Tab, or Model, and then click Edit to modify an existing

annotation, or Add to add a new one.

3. To add a link, do one of the following:

● To add a link to a Web page, in the annotation edit box, type a valid URL, such as: http:/

/www.Cognos.com.

● To add a link to an email address, type the HTML link command as follows:

mailto:email address

Clicking this link opens a new mail message window in your default browser, and puts the

email address in the To: field.

● To add a link to a file, type the HTML link command as follows:

file:\\unc_drive_name\docs\expenses.xls

Tip: To view the annotation with a clickable link, right-click in the cell, tab or model, and click

Annotate, then click Cell, Tab, or Model, and then click View.
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Attach Documents
You can attach many types of files to a cell, cube, or model to help support your planning process.

The types of files that can be attached are configured by the administrator in the Contributor

Administration Console. The attachments are stored in a Planning Application database.

The following default file types are allowed:

● Microsoft Word (.doc)

● Microsoft Excel (.xls)

● Microsoft PowerPoint (.ppt)

● Microsoft Visio (.vsd)

● Microsoft Project (.mpp)

● ZIP Files (.zip)

● RAR Files (.rar)

● Web Documents (.htm, .html)

● Text Files (.txt)

● PDF Files (.pdf)

You can add or remove any required file type from the defaults provided. Executable files (.exe)

are not included in the default list because of security reasons, but can be added by the Administrator.

Attaching a Document

You can attach a document to a cell, tab, or model in the Contributor Web application.

Note: You can also do this in Contributor for Excel.

Steps

1. In the Contributor workflow screen, click on an available e.List item you want to open.

2. In the Contributor grid, you can either click on the Attached Documents button or right-click

in a cell and select either cell, tab, or model and click Add. The Attach a new document dialog

box appears.

3. In the Source file location field, enter either the location, the file, or click the browse button

and browse to the file location. The document name and file size appear in the following fields.

4. Enter comments into the Comments field. There is a 50 character maximum limit for this field.

5. Click OK to attach your document.

A red triangle appears in the corner of the cell to which the document is attached. A copy of the

document is attached to the application, not the original file. This is similar to attaching a file to

an email and is not meant to perform as a document management system.
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Viewing and Editing Commentary

Attached documents and user annotations that are linked to a plan are grouped together and are

called Commentary. You can view an attached document by browsing the Commentary of an

application. Attached documents do not download when the e.List item is opened. They are only

downloaded from the application server when you select to view or edit them.

Note: Attached documents are not available when working offline and you cannot attach a document

while working offline. However, it is possible to see if a document is attached to a cell while offline.

Steps

1. In the Contributor grid, click the Browse Commentary button or right-click a cell and select

Browse Commentary. An icon also appears in the Contributor workflow screen notifying you

that one or more documents are attached to an e.List item. However, you cannot open attached

documents from the workflow screen.

2. In the Commentary Browser dialog box, select the commentary item that you want to view

and click View Document to open the file. You can filter the items to just show user annotations

or attached documents. You can also choose whether to view Commentary for the current page

in the grid or Commentary for all pages.

3. To edit commentary, select the commentary item and click Edit Document. The item opens

allowing you to make changes and save the new version along with the application. You will

be prompted to update the repository if you made changes to the file.

4. To delete commentary, select the check box for the item you want to delete and click Delete.

Note: Only the owner or the Contributor administrator can delete an attached document.

5. You can print an annotation by selecting the file and clicking Print. To print a document, open

it and print from the associated viewer.

Using Local Links to Move Commentary

Create a Local Link to copy commentary such as file attachments or user annotations.

Note: You cannot target calculated cells using a Local Link.

Steps

1. In the Contributor grid, launch Get Data.

2. In the Run Local Links screen, click New to create a new Local Link. Complete the information

in the wizard.

3. In the Additional Options screen of the Get Data dialog box, you can choose to include

annotations or attached documents. Do one of the following:

Note: You cannot select Model Commentary for a Local Link.

● To include only Annotations, click Include Annotations.
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● To include only Attached Documents, click Include Attached Documents.

4. Click Finish when you are done configuring the link.
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Chapter 3: Work Offline

If you need to work in Cognos 8 Planning - Contributor, but you are temporarily unable to connect

to a network, you can work offline if you have sufficient rights. For example, you can view and

edit your plan while travelling.

Important: Ensure that you bring your data online as soon as possible to prevent data loss in the

event of administration changes, and to ensure accurate data readings.

Steps

1. Open the e.List item while online.

2. If you want to edit or annotate offline and you are not the current editor, click Take ownership
.

3. From the File menu, click Work Offline. This disconnects the server from this session while

leaving the session open.

You can now edit information offline.

Note: In the offline browser, when you click Save, it saves to the offline store and does not

connect to the server. Any annotations become read-only and data changes color to indicate

that it was saved. You cannot view attached documents in offline mode, you will only be able

to determine that a document is attached.

Take Work Back Online
Changes made while offline are not saved to the server until you save or submit while online. When

you bring an e.List item view back online, annotations can be edited and you can attached documents

(if available).

Steps

1. In the offline browser, click File, Work Online.

The online browser restarts and you are prompted to bring the offline data online.

2. Click Yes.

The view you took offline opens with the current offline data and the offline browser closes.

The data color reflects the changes between the current data and the data stored on the server.

3. To save or submit your changes to the server, do one of the following:

● To save the changes you made while offline to the server, click File, and then click Save.

● To submit the changes you made while offline to the server, click File, and then click Submit.
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Chapter 4: Export Contributor Data to Excel

You can export Contributor data to Excel if this feature is enabled by your administrator. You can

export data to Excel to create reports, charts, and manipulate the data using the functionality of

Excel.

Steps

1. From the Tools menu, click Export for Excel.

Note: The name of the menu item is configurable by your administrator.

2. Choose one of these options:

● Current view only: this exports the active page in the selected tab to Excel.

● Refresh existing report: this refreshes an existing report with updated Contributor data.

● Define a new report: this creates a new report.

3. If you selected Refresh existing reports, configure the options as follows:

● To add new reports click Add and then browse to the report location. You can also remove

reports.

● Prompt to Resolve Layout Issues compares the data from the existing report with the current

data. If there are layout differences such as added or deleted rows, columns, pages, or

headers, you are prompted.

● Ignore Layout Issues ignores any layout issues between the existing report and the newly

created report.

● Generate Layout Issue Report generates a report describing each structural difference

between the model and the report.

● Update Captions updates row, column, and sheet caption strings from the model data.

4. If you selected Define a new report, configure the options as follows:

● Choose what type of Selection (p. 30) you want to use with your export. You can include

commentary with your selections.

● Select which Tabs you want to include in this report. You can choose all of the tabs.

● Select the data from each Tab that you want to export.

● Use Selection reuses an existing saved selection.

● Choose an orientation for the selection. Note that multiple dimension selections will be

laminated. If you have duplicate header cells, select the Merge Duplicate Header Cells check

box to merge them.
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Selections
Selections are sets of data from a Contributor application grouped together to create specific reports.

These selections can be made up of data from one or more tabs within your Contributor application.

Once selections are created and saved, they are called saved selections and are stored in a specific

location determined by your Contributor Administrator.

For more information about configuring Export for Excel, see the Contributor Administration

Guide.

Choose which selection option you want to use:

● New Selection - creates a new selection of data. You can choose to include commentary.

● (Optional) to reuse this selection later, type a name for the new selection in the field. This name

should represent what the data selection is (such as 2001 Revenue, Eastern Region Expenses,

etc.).

● Edit Selection - changes the structure of an existing selection.

● Use Selection - uses a previously saved selection without changing the structure. If the structure

of a previously saved selection has changed significantly (because of a model change), that

selection may not be compatible and would need to be recreated.

● Include Commentary - to include any commentary with your selection. You cannot select

Include Commentary for a previously saved selection if the commentary was not included as

part of the original selection creation. Choose Edit Selection if you want to include commentary

with this selection.
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Chapter 5: Get Data

You can run two different types of links using the Get Data tool: Local and System Links.

Local Links
Local Links are created directly in Get Data. They load data into Cognos 8 Planning - Contributor

from various sources, including other Contributor tabs.

System Links
Systems Links are created by the Contributor administrator and are deployed to users in designated

users, groups, or roles. System Links are defined in Contributor Administration Console and cannot

be edited or shared by web users. System Links can use source data from other Contributor

applications in the same Planning Store.

Link States
The Run Links dialog box lists all links (Local or System) that are available with your open

Contributor grid and the status of those links.

Links can exist in two states: Ready or Incomplete .

The Ready icon appears when the link definition is correctly defined. All source dimensions are

mapped to a target dimension or at least one item from each unmapped source and target dimension

is selected. You can run a link only if it is in a ready state.

The Incomplete icon  appears when the link definition is not defined correctly or when it is

incomplete. You cannot run a link if the load definition is incomplete. The link definition may not

be complete because

● the Source or Target tabs are not selected

● columns or rows are not marked as description

● extra source or target dimensions exist

Local Links
A Local Link is a mapping between a set of data that you want to either import into your e.List

item(s) in the Contributor Grid or move to a different location in the open e.List item in the

Contributor Grid. A Local Link is made up of the source data, items in the source, commentary,

and the target tab of the source data.
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Link definitions can be created using external data sources or tabs in the active Contributor Grid.

Link Definitions can be modified and distributed after creation. Link definitions can be stored as

a *.cld file.

In Get Data, you can create (p. 32) and run (p. 31) a Local Link.

Create a Local Link
Create a Local Link so that you can load data from the following types of sources:

● ASCII files

You create ASCII links when you want to load data from text files.

● Excel

You create Excel links when you want to load data from a single worksheet from an Excel

workbook. You can also use an .xls file that was created using Contributor Export for Excel.

Important: When using an Excel file as the source, in order for breakback to work, you must

first delete the appropriate rows in file before importing.

With the breakback functionality, detailed cell entry takes precedence over the breakback.

When importing an Excel file, cells that are blank are treated as zeros. Therefore, after

performing the import with cells that are blank, the detailed cell entries will be imported with

zeros. This will cause expected breakback results to not appear within the grid.

In order for the breakback to properly occur, the rows to be included in the breakback must

be removed from the source file. After this is done and the link is executed, breakback will

occur and the expected results will appear on the Contributor grid.

● Local Contributor Data

You create a Contributor-to-Contributor link when you want to move data in the active

Contributor Grid. Data can be moved inside a single tab or from one tab to another.

Steps

1. Open Get Data.

2. In the Run Local Links dialog box, click the New button.

The Define Source Type and Destination dialog box appears.

3. In the Link Name box, enter a name for the new load.

Link names must be unique and cannot contain these characters: ’\ /:*?"<>|.

4. In the Description box, enter a brief description of the source and target of the link.

Tip: This information is useful when sharing links with other users.

5. In the Data source type box, click the data source type you want.

6. In the Pick source tab list, if you are using Contributor data, click a source tab where you want

the data loaded from.
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7. In the Pick target tab list, if you are using Excel or ASCII data as the source, click a target tab

where you want the data loaded into and click Next.

The Pick Source Data dialog box appears.

8. In the Source box, enter the file name.

9. Provide the information required for your source file type:

● For an ASCII file with fixed width columns, click Fixed width columns.

● For an ASCII delimited file, specify the delimiter and the text qualifier that the file uses.

● For an Excel Spreadsheet, choose a worksheet if required.

● For a Contributor tab, specify the source and target tab.

10. Click Next to continue.

The Map Source to Target dialog box appears.

11. In the top work area, select each row or column that you want to identify as description data

and click Description. The Description icon appears .

Description columns cannot follow Data columns in the source file.

12. Select each row or column that contains data for loading and click Values.

13. If some data is not numeric, right-click each column or row that contains non-numeric data,

click Data Format, and click Text, Number, or Date.

14. If some rows or columns of source data are not needed, select each of these rows or columns

and click Ignore.

The Ignore icon  appears in the header.

15. In the Start import at row box, enter the row number that you want to start your import with

if you do not want to load data beginning with the first row.

16. If you want, rename the rows and columns (p. 34).

17. If you want, split a column or merge dimensions (p. 35).

You must now map the dimensions.

The Map Source to Target Dialog Box

The Map Source to Target dialog box is divided into two work areas:

The upper area is where you identify your source dimensions as data, description information, or

unnecessary rows and columns. You can also rename columns and rows to make the link definition

easier to understand. This is where you merge or split columns depending on what your target

dimension requires.
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The lower area is where you map source dimensions to target dimensions. You can map one or

more source dimensions to a target dimension manually or you can choose Map All to map

dimensions with the same name. You can also edit and clear any mapped dimensions.

Rename Rows or Columns
When you preview your source files in Get Data, the headers are automatically renamed. For

example, columns are renamed to C1, C2, and rows are renamed to R1, and R2.

You can rename your columns and rows by manually renaming the rows and columns or renaming

columns using existing column headers.

Tip: Renaming rows and columns the same name as target dimensions helps to easily identify which

source and target dimensions match. You can then use the Map All feature.

Steps to Manually Rename Row and Columns

1. In the Map Source to Target dialog box, select a row or column header and click Rename.

2. Enter a new heading.

3. Click OK.

Renaming Columns Using Row Header

To use row header, do the following:
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● In the Map Source to Target dialog box, in the Rename columns using row box, enter the

number of the row that contains the original names you want to use for each Description

column.

This does not change dynamically with the data.

Split a Column

You can split a column whose information must be mapped to two or more separate target

dimensions. For example, you have a source dimension that lists dates in the format Jan-03 and

two target dimensions, one for month and one for year. You must split the source dimension into

two sub-dimensions to correctly load the data.

Note: You cannot split a dimension already marked as a Description.

Steps

1. In the Map Source to Target dialog box, select the source dimension (row or column) that you

want to split and click Split.

2. Position your pointer where you want to split the data, left-click, and drag the line into position.

3. Right-click the character to remove the split bar.

4. Click OK.

Merge Dimensions

You can merge two or more source dimensions to map them to one target dimension. For example,

you want to merge a source dimension for years (03) and a source dimension for months (Jan) into

one dimension (Jan 03) and map it to the target dimension of months and year (Jan 03).

Note: You cannot merge two dimensions when either is already marked as Description.

You can also undo a split by merging the new dimensions.

Steps

1. Select the columns or rows that you want to merge.

2. Click Merge.

Map Dimensions

You must map the source dimensions to the target dimensions for loading.

You can either map source and target dimensions with the same names automatically, or manually

map source dimensions to target dimensions.

Tip: You can tell what type of mapping was used by pausing the pointer over the connecting line

between the source and target dimensions.
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You can quickly map your source and target dimensions when the names of each already match.

This feature is useful when working with large files that contain many rows and columns.

The Map All button is available only if you have at least one set of matching dimensions.

If the items in the source and target dimensions do not match, a manual map is required. For

example, if the source item is Jan-03 and the target items is 1-03, a manual map is required. If the

items in a source or target of the manually mapped load are added, the load must be manually

updated.

Steps for Automatic Mapping

1. If the names do not already match, in the Map Source to Target dialog box, rename the columns

and rows to the same names as their corresponding target dimensions.

2. Click Map All.

A single line connects paired dimensions.

Tips: Double-click the connecting line (or either dimension) to confirm that the items in the

dimensions are mapped correctly.

To change the link properties, click the line and click Edit. To remove the link, click the line

and click Clear. To remove all links, click Clear All.

Steps for Manually Mapping

1. In the Map Items dialog box, select a source dimension and a target dimension and then click

Map.

The Map Items dialog box appears. Any matching dimension items are highlighted.

Tip: Select the Case sensitive check box if you want to map items based on capitalization and

the Calculated items check box if you want to map the calculated items.

2. Click OK to accept the highlighted dimension items.

The Map Source to Target dialog box reappears.

3. If unmatched items remain in the Map Items dialog box, click Manually Map and do the

following:

● In the Source Items box, select a source item.

● In the Target Items box, select a target item.

● Click Add.

● Click OK.

The Map Source to Target dialog box reappears. A line connects single/paired dimensions.

4. Click Next. The Additional Options dialog box appears.

To include annotations, select Include Annotations.

To include attached documents, select Include Attached Documents.
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5. Click Finish when you are done configuring the link element.

6. The Run Local Links dialog box reappears listing the new Local Link and whether it is Ready

or Incomplete.

View Items in a Dimension
You can view only the first 50 detail items in a dimension.

Steps

1. Select either a source or target dimension.

2. Under the dimension name, click the Preview button .

Remove Dimensions
You can remove a selected dimension from the Source Dimensions list in the Map Source to Target
dialog box.

Steps

1. In the Map Source to Target dialog box, select the source dimension you want to remove.

2. Click the Remove button .

This removes the description designation from a row or column. The row or column is now

treated as values.

Filtering Dimension Items by Characters

You can filter dimension items that appear in the Dimension Items list based on the first character

or more than one character in the item name.

Note: This filter only applies to items that appear in the list. It does not affect what gets loaded

into the target.

Step

● In the Map Items dialog box, in the Filter box, enter the character or characters you want to

filter on.

Only the items that begin with the character or character you entered in the filter box appear

in the Dimension Items list.

Tip: To remove the filter, delete the characters in the Filter box .

Filter Dimension Items by Substrings

You can filter Dimension items using a substring filter based on the character position. For example,

you can filter items to just the third, fourth, and fifth characters of each item.
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When you use a substring, all the items that match the substring are rolled up into one item. For

example, if you have dimension items named Budget 1, Budget 2, and Budget 3 and if you applied

the substring BUD to the first three characters, all three items are rolled into one dimension item

to be loaded into the target dimension.

Unlike filtering by characters, using a substring applies to what is included in the load as well as

what is viewed in the Dimension Items list. You can use substrings when mapping dimensions

manually or automatically.

Steps

1. In the Map Items dialog box, click Substring.

The Select substring dialog box appears with the longest item name in the dimension list.

2. Clear the check boxes below the characters that you do not want to appear in the dimension

list.

Tip: Drag the pointer to clear more than one check box at a time.

3. Click OK.

The dimension items are now filtered by the characters in the positions you selected.

Unmapped Dimensions

Mapping creates relationships between one or more source dimensions and a target dimension.

When all source and target dimensions are mapped, the load definition is ready. Sometimes, the

source and target do not have the same number of dimensions or some source dimensions are not

meant to be mapped directly to a target dimension. All dimensions must either be mapped or dealt

with before you can run a load.

The load appears in the Run Loads list with either a ready or incomplete symbol.

Resolve Unmapped Source Dimensions

Unmapped source dimensions are dimensions that are not mapped to a target dimension. You must

designate the items on each unmapped source dimension that are to be included in the load. At

least one item from every unmapped dimension must be selected or no data from the source will

be loaded and the link will be incomplete.

Note: All source dimensions must be addressed, either by being mapped to a target dimension or

by having items selected for inclusion on the Unmapped Dimensions dialog box. Otherwise the

load will not be marked as complete and cannot be executed.

Steps

1. In the Pick Unmapped Source Dimensions Items dialog box, in the Available list, select which

dimension items should be loaded.

If you select more than one item, the aggregated total is loaded into the target.
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2. Select the All items check box if you want to include all items and any items added in the future

to the source dimension.

3. Click Next.

4. Repeat for any unmapped source dimension items.

Resolve Unmapped Target Dimensions

Unmapped target dimensions are target dimensions without any source dimensions mapped to it.

All target dimensions must be addressed, either by being mapped with a source dimension or by

having items selected for inclusion. Otherwise the load will not be marked complete and can not

be run.

Steps

1. In the Pick Unmapped Target Dimensions Items dialog box, in the Available list, select which

dimension items should be targeted by the source data.

The same value is loaded into all items selected.

2. Select the All detail items check box if you want to include all the current items and any future

items added to the target dimension.

3. Click Finish.

Add an Existing Link Definition

You can add link definitions to the Local Links list that were created by other Contributor users.

Steps

1. Click Add.

2. Find the link definition file (*.cld).

3. Click Open.

The newly added link definition appears in the Local Links list. You can now edit or run this

link definition.

Share a Link Definition
You can share link definitions with other Contributor users by distributing link definitions through

email or network locations.

Users must have submit or edit access to the target cube that is defined in the link definition to run

the link. You define access privileges in Contributor Administration Console.

Steps

1. In the Local Links list, select the link definition that you want to share.
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2. Click Save as to save the link definition to your local computer, or to a network location.

3. Make the link definition file (*.cld) and the source file (*.xls or *.txt) available to other users.

Users can now add the link definition file to the Local Links list (p. 39). If they want to change

the current location of the source file or use a different source, they must modify the link

definition.

Run a Local Link
To load data into a target Contributor tab, you must have edit or submit rights for that tab. You

cannot load data into tabs that are read-only.

Steps

1. In the Local Links list, select the Local Link that you want to run.

Multiple loads run consecutively.

Tip: You can control the order that the Local Links run in by adding them to the Local Links
list in the desired order.

2. Click Run.

3. Click OK when the link is finished running.

Quick Load

You can load data from an Export for Excel file by using the Quick Load feature.

Steps

1. In the Local Links dialog box, click the Quick Load button.

2. Under Export for Excel file, in the Source box, enter the file name.

3. Choose the worksheets you want to load.

Tip: You can also click the Select All button or the Deselect All button.

4. Preview the file in the preview window.

5. Click Run.

Run a System Link

You can run only System Links if the Contributor administrator grants you access to them. You

cannot create a System Link.
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Tip: To view the System Link execution history which includes when a link was run and by whom,

click the History button.

Steps

1. In the System Links list, select the System Link that you want to run.

2. Click Run.

If errors exist, you are prompted to view or ignore them.
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Chapter 6: Troubleshooting

This chapter identifies issues that may require troubleshooting and suggests causes and actions to

take.

An Extension Does Not Download
The first time you activate an extension a message appears stating that a one-time download to

your computer is required. If you accept this download and nothing happens, the extension CAB

file containing the needed files may not be properly configured in the Cognos 8 Planning -

Contributor Administration Console. This causes the download to stop.

Confirm that the CAB files are copied to the Controls folder of the Contributor Web site at

install_location\c8\webcontent\contributor\CONTROLS.

This does not apply if your company uses an automated software delivery system, such as Microsoft

SMS, to deploy client software or if your network administrator designated a different method of

installing Extensions besides through the Contributor grid.

Get Data Troubleshooting
You may encounter problems when using Get Data. We provided information to help you do

troubleshooting.

Cannot Access an Item in the Target Dimension

If a source dimension is manually mapped to a targeted dimension and you cannot access an item

in the targeted dimension, it may be because the target item is either deleted from the model or

hidden using access tables.

To correct this problem, you can map the source dimension item to another target dimension item

or remove the manual map entry. Verify your access to those dimensions.

Cannot Access a Dimension Item In the Target Cube

If an error message indicates that Get Data cannot access a dimension item in the cube, it may be

because the target dimension was removed from the model or hidden using access tables.

To correct this problem, edit the load definition to manage the source dimension as an extra

dimension or map it to another target dimension. Also, confirm your access to the target dimension.
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Extra Source Dimension in a Contributor-To-Contributor Load
If an error message indicates that an extra source dimension exists in a Contributor-to-Contributor

load, it may be because an extra source dimension existed in the load. Perhaps one Dimension item

from the source is included that was deleted from the model or hidden using access tables.

To correct this problem, edit the load definition to manage the extra source dimension by including

at least one of its items.

Item Removed from the Target Dimension

If an error message indicates that an item was removed from the target dimension, it may be because

an item was deleted from the model or hidden using access tables.

To correct this problem, edit the load definition to manage the extra target dimension by including

at least one of the remaining items.

An Extra Target Dimension Exists

If an error message indicates that an extra target dimension exists, it may be because a new dimension

was added to the target cube after a load definition was successfully completed. The load is then

considered out of date or incomplete.

To correct this problem, edit the load definition to manage the newly added dimension as an extra

target dimension and includes at least one of its items.

Missing Source Dimension in a Contributor-To-Contributor Load

If an error message indicates that there is a missing source dimension in your

Contributor-to-Contributor load, it may be because a source dimension was removed from the

model or was hidden using access tables.

To correct this problem, edit the load definition to manage the target dimension that was mapped

to the source dimension. Map it to another source dimension or treat it as an extra target dimension

and include at least one of its items.

Additional Source Dimension Exists in a Contributor-To-Contributor Load
If an error message indicates that an additional source dimension exists in your

Contributor-to-Contributor load, it may be because a dimension was added to the source after a

load definition was successfully completed.

To correct this problem, edit the load definition to manage the new source dimension either by

mapping it to an existing target dimension or treating it as an extra source dimension.

Target Cube is Read-Only

If an error message indicates that the target cube is read-only, most likely the user has not taken

ownership yet.
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If a reviewer e.List item is open, that user may not have reviewer edit rights, or all cubes are read-only

using access tables.

Export for Excel Troubleshooting
This section reviews formatting issues that occur in Export for Excel.

Structural Differences
Structural differences are discrepancies between the existing Excel report and the current model

data within Contributor that will be used to refresh the report. If the two structures are different,

a message will appear notifying you of the difference and ask you whether or not you want to

resolve the difference.

If you choose:

● Yes, a missing item is inserted into the worksheet or an unknown item is removed from the

worksheet.

● No, the difference is maintained in the worksheet.

● Cancel, aborts the refresh operation.

Laminations
Laminations are two or more dimensions merged into one axis (row or column). You can use

laminations to reduce the number of pages in your report by moving page dimensions to either

rows or columns.

Merge Duplicate Header Cells

When the header cells of laminated dimensions are merged, the repeated sequential header names

are shown in merged cells rather than repeated in each unmerged cell. See example below.

Not MergedMerged

YAY

XBXB

Y
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Glossary

application

In Cognos Planning, a Contributor application. Contributor applications are used for the collection

and review of data from hundreds, or thousands of Web servers. One application can be used by

many users in different locations at the same time.

breakback

A function that changes the value of variables to make a formula equal to a specified value.

Cognos Planning - Analyst

A tool for defining business plans. It enables you to establish the structure that defines the key

drivers and content required for planning, budgeting, and forecasting, and the distribution of

templates to managers.

commentary

In Cognos Planning, commentary represents any additional information attached to Contributor

cells, tabs, or e.List items, including both user annotations and attached files. You can use

administration links, system links and local links to copy commentary.

contribution

In Cognos Planning, data that is entered into an e.List in the Contributor application.

Contributor Administration Console

A tool which enables administrators to publish an Analyst business model to the Web, manage

access settings and model distribution, and configure the user's view of the model.

cube

A physical data source containing a multidimensional representation of data. A cube contains

information organized into dimensions and optimized to provide faster retrieval and navigation in

reports. In Cognos Planning, a cube (see also D-Cube) corresponds to a tab on Contributor client

user interface.

current owner

In Contributor, the person who is editing or lasted opened an e.List item for edit.
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dimension

In Cognos Planning, the rows, columns, and pages of a cube are created from dimensions. Dimensions

are lists of related items such as Profit and Loss items, months, products, customers, and cost centers.

Dimensions also contain all the calculations. One dimension can be used by many cubes.

In Cognos 8 BI a dimension is a broad grouping of descriptive data about a major aspect of a

business, such as products, dates, or markets. Each dimension includes different levels of members

in one or more hierarchies and an optional set of calculated members.

D-link

In Analyst, a link that copies information in and out of cubes, and sometimes to and from text or

ASCII files.

D-list

An alternative term for dimension.

e.List

The basis for the structure of a Contributor application. An e.List is a hierarchical dimension which

typically reflects the structure of the organization (for example, cost centers and profit centers).

editor

In Cognos Planning, a planner or reviewer who is editing a contribution

extensions

In Cognos Planning, extends the functionality of the Contributor Administration Console and Web

Client. There are two types of extensions: Admin Extensions and Client Extensions. Admin

Extensions run in the Administration Console. Client Extensions are activated from the tool options

on the Contributor Grid.

hold

In Cognos Planning, a function that protects a cell against breakback.

lock

In Cognos Planning, a function that prevents data being entered into cells whether by typing or via

a D-Link.

offline grid

In Cognos Planning, the application that is used to access a section of an offline Contributor

application. The purpose is to enable users to enter or view data while there is no network

connection.
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owner

In Contributor, a user who is assigned to an e.List item through the Rights screen and is permitted

to edit or review it. These rights may be directly assigned, or may be inherited.

planner

In Cognos Planning, a person who enters data in the Contributor application in the Web client.

protect

In Cognos Planning, a function that is used to prevent data from being typed into a cell. However,

data can still be transferred into a protected cell via a D-Link.

publish

In Cognos 8 BI, refers to the creation of a package that makes metadata available to the Cognos 8

server. Information in the package is used to create reports and other content.

In Cognos Planning, refers to a function that is used to copy the data from Contributor or Analyst

to a datastore, typically so it can be used for reporting purposes.

reconciliation

In Cognos Planning, a process that ensures that the copy of the Contributor application that the

user accesses on the Web is up to date, for example, all data is imported. Reconciliation takes place

after Go to Production has run and a new production application is created.

refresh

In Cognos Planning, this occurs when you update data in an existing report or an export saved

selection using an extension.

reviewer

In Cognos Planning, a person who reviews the submissions of reviewers or planners.
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A

Add command, 19

adding

links to annotations, 23

annotating

cells, 22

data, 22

models, 22

tabs, 22

annotations

adding links, 23

audit, 23

browse, 22

user, 22

viewing, 22

applications

definition, 47

attach documents, 24

attached documents, 24

attaching, 24

attaching a document, 24

audit annotations, 23

B

best practices, 5

breakback, 17

definition, 47

browse annotations, 22

C

calculated cells, 17

entering data, 17

cells

annotating, 22

validating, 11

changing

page dimensions displayed in views, 15

Cognos Planning - Analyst

definition, 47

Cognos Planning - Contributor, 7

workflow screen, 8

commentary

definition, 47

moving with local links, 25

viewing and editing, 25

contributions, 8

definition, 47

Contributor, 7

workflow screen, 8

Contributor Administration Console

definition, 47

copy commands, 19

copying, 13

copyright material

printing, 6

copy URL, 21

cubes

definition, 47

current owners

definition, 47

cutting, 13

D

data

annotating, 22

editing, 17

rejecting, 17

reviewing, 17

saving, 16

submitting, 17

submitting for review, 16

validating, 11

viewing, 11

data entry commands, 19, 22

data integrity

enforcing, 11

Decrease command, 19

dimensions

definition, 47
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Divide command, 19

D-Links

definition, 48

D-Lists

definition, 48

E

e.List items, 9

rejecting, 17

reviewing, 17

e.Lists

definition, 48

editing, 13

data, 17

editors

definition, 48

emails, 7

entering data, 11

calculated cells, 17

copy commands, 19

data entry commands, 19

quick commands, 19

validating, 11

exporting data, 13

extensions

definition, 48

F

finding information, 6

full precision numbers, 16

G

Get Data, 14

Global Customer Services Web site, 6

Grow commands, 19

H

help

getting, 6

hiding

pages containing only zeros, 15

hold

definition, 48

holds, 17

applying, 18

I

importing data, 13

incomplete, 8

Increase command, 19

information

finding, 6

K

K command, 19

L

links

adding to annotations, 23

link to Contributor cell, 21

load from file, 13

local links

using to move commentary, 25

lock

definition, 48

locked, 8

log on, 7

M

Mapping dimensions

unmapped target dimensions, 39

M command, 19

models

annotating, 22

modifying views, 11

changing page dimensions, 15

hiding pages containing only zeros, 15

page dimensions with row headings, 15

replacing columns with page dimensions, 15

replacing page dimensions with column headings, 15

replacing rows with page dimensions, 15

swapping rows and columns, 15

multi-e.List item views, 9

Multiply command, 19

N

not started, 8

O

offline grids

definition, 48
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offline working, 27

online working, 27

owners

definition, 48

P

pasting, 13

Percent command, 19

planners

definition, 49

Power command, 19

printing copyright material, 6

protect

definition, 49

publishing

definition, 49

Q

quick commands, 19

copy commands, 19

data entry commands, 19

R

ready, 8

reconciliation

definition, 49

refresh

definition, 49

Refresh, 29

reject, 9

rejecting

data, 17

e.List items, 17

related documentation, 5

replacing

columns with page dimensions, 15

page dimensions with column headings, 15

page dimensions with row headings, 15

rows with page dimensions, 15

Reset command, 19

resetting data, 14

reviewers

definition, 49

reviewing e.List items, 17

editing, 17

rejecting, 17

rounding

view full precision numbers, 16

S

save to file, 14

saving

data, 16

submitting

data for review, 16

submitting data, 17

Subtract command, 19

swapping

rows and columns, 15

T

table

workflow screen, 8

tabs

annotating, 22

take ownership, 11

tree

workflow screen, 8

Troubleshooting

additional source dimension exists in a

Contributor-To-Contributor load, 44

an extra target dimension exists, 44

cannot access a dimension item in the target cube, 43

cannot access an item in the target dimension, 43

extra source dimension in a

Contributor-To-Contributor load, 44

item removed from the target dimension, 44

missing source dimension in a

Contributor-To-Contributor load, 44

target cube is read-only, 44

U

Update command, 14

users

annotations, 22

V

Validate Data command, 11

validation of data, 11
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viewing

annotation links, 23

annotations, 22

data, 11

viewing data

modifying views, 11

views

modifying, 11

W

workflow screen, 8

Contributions, 8

e.List items, 9

multi-e.List item views, 9

reviews, 8

table, 8

tree, 8

working

offline, 27

online, 27

work in progress, 8

Z

Zero command, 19
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